You are about to experience CircuitMaker, a powerful, yet simple to use, schematic capture and circuit simulation program. CircuitMaker’s user friendly interface allows you to quickly and easily draw, modify and combine analog and digital circuit diagrams. Using CircuitMaker’s built-in simulation capabilities, you will be able to expand into new areas of electronics at no additional expense. CircuitMaker’s many unique features relieve the frustration in circuit design and encourage creativity and exploration.

Getting Started

“If you’re a student or teacher, you’ll find the ability to quickly design and test circuits makes this product a first-rate classroom aid.”
Macworld, August 1993, page 164.

Drawing a Schematic

To draw a circuit diagram, you simply use the mouse to select devices from the library and to connect wires between the devices. Features such as Auto Routing and SmartWires® simplify the task of drawing any circuit. Editing features, including rubberband move of wires and devices, cut, copy and paste, the ability to rotate and mirror devices, and the ability to spread the circuit out over several pages, further simplify the circuit drawing process.

To begin, go to the File menu and open the file labeled “SCHEMA.CIR”. A simple, partially drawn schematic will appear on your screen. Select a Logic Display from the 1A (Library 1) pulldown menu. Place the display on your screen as shown in Diagram A by clicking the left mouse button.
Select the Wire Tool from the Toolbar and center the cursor on the output pin of the Logic Switch.

Click and hold the left mouse button, then drag the wire to the input pin of the inverter (see Diagram B) and release the mouse button to connect the wire. A round dot will appear at each end of the wire to confirm the connection.

You don’t need to be exact when aligning the wire to the pin. CircuitMaker has a feature called SmartWires™ which automatically adjusts the wire, connecting it to the input pin. When the cursor gets close to the pin, a small rectangle is displayed, highlighting the pin. The wire will snap to the point highlighted by the rectangle. The size of the rectangle is user programmable in the Preferences dialog box. Wires can be moved around with the Arrow Tool after they have been placed in the circuit.

As shown in Diagram C, position the cursor over the output pin of the inverter. Click and hold the mouse button, then drag the end of the wire to the pin of the Logic Display (see Diagram D) and release the mouse button.

Manual routing of wires is also available. To route wires manually, select the Wire Tool, then click and release the mouse button to start the wire. Drag the mouse in the direction you want to go (horizontal or vertical). An extended wiring cursor is displayed to help you precisely align wires with other wires, devices, etc. Click once to turn the wire 90°. Double-click to end the wire or single-click on a device pin or wire.

CircuitMaker uses a feature known as “rubberbanding”. This allows you to move a device or wire, while still maintaining full circuit connectivity. To do this, select the Arrow Tool from the Toolbar. Select the display or any other device wired to the sample circuit, drag it to a new location and drop it.

Select the Delete Tool from the Toolbar. Place the tip of the Delete Tool on a device or wire and click. Use the Delete Tool to quickly and easily delete unwanted wires, devices and text. To undelete, type Ctrl+Z.

CircuitMaker allows you to place multi-line, fully stylized text anywhere in the schematic. To place text, select the Text Tool in the Toolbar, move the cursor to the desired location and click.

These are the basics of drawing a schematic within the CircuitMaker environment. With CircuitMaker, drawing schematics can be fast, flexible and fun.

One of the most powerful features of CircuitMaker is its ability to simulate your design. This enables you to detect and correct design errors prior to investing time and money in the construction of actual hardware prototypes.

CircuitMaker is capable of running two different types of simulations and it is important to understand the differences. The Digital/Analog button in the Toolbar indicates which simulation mode is selected.
Digital electronics is the world of the computer. The binary 1's and 0's of the computer are actually the high and low voltage levels of tiny electronic devices known as integrated circuits. Digital simulation, then, becomes a relatively simple task because of the limited number of digital states that must be represented. The digital devices and instruments in the libraries—gates, 7400 series devices, data sequencer, etc.—are intended to be used with the digital simulator only. The digital simulator is quick and fully interactive, meaning that you can flip switches, altering the circuit with the simulation free running and immediately see the response of the circuit.

Analog is the classic world of electronics. There are no logic state restrictions as in digital electronics; the voltage level of any given circuit node is not limited to a high or low. Analog simulation, therefore, is much more complex. CircuitMaker's analog simulation is based on Berkeley SPICE3 which provides the simulation model for a wide variety of analog devices, including both passive and active devices. The analog devices and instruments in the libraries—capacitors, transistors, signal generator, etc.—are intended to be used with the analog simulator only. The analog simulator generates a data set based on the analysis parameters selected by the user. This data can then be analyzed in the graphics windows.

Go to the File menu and open the file "SIM.CIR". On your screen, you will observe three simple circuits. They are designed to introduce you to the digital simulation features of CircuitMaker.

To start a simulation, click on the Run button in the Toolbar. To stop a simulation, click on the Stop button that replaced the Run button in the Toolbar. To reset the circuit to the starting state, click on the Reset button in the Toolbar.

**Start the simulation** by clicking on the Run button in the Toolbar. **Toggle the position of the switch** in the sample circuit by clicking on it. Operation of the circuit can be observed in four ways:

1. **Select the Probe Tool** from the Toolbar and touch the tip on any wire or device pin. The triangle indicator in the Probe Tool indicates the respective high or low state of the node being probed. If no triangle appears, this indicates an unknown state. A node can be probed while the simulation is running or after it has stopped.

   The tip of the Probe Tool can be used as a pointer to toggle the position of a switch. When clicked on a wire or device pin, it will toggle the state of that node.

2. Circuit operation can be observed by connecting any of a variety of displays and then monitoring the conditions shown on them. **Observe the displays in the circuit.**
3. Enable the Trace feature by clicking on the Trace button in the Toolbar. The state of every node in the circuit is shown simultaneously as the simulation runs. In this mode wires at a logic one are shown as red, wires at a logic zero as blue, and wires at an unknown or tri-state as green. Note: all colors are user definable within the View menu.

4. Any number of logic scope probes can be connected at any point in the circuit, thus causing the timing diagrams for those nodes to be shown in a separate digital Waveforms window. To observe the timing diagrams, click on the Waveforms button in the Toolbar. A separate Waveforms window will appear.

CircuitMaker gives the user the option of setting breakpoints. When a breakpoint occurs the simulation will halt. In the Waveforms window shown to the left, a breakpoint is set to occur when A1 is low and A2 is high.

Stop the simulation by clicking on the Stop button that replaced the Run button in the Toolbar. Set the breakpoint conditions for your circuit to be the same as the example to the left. To accomplish this, click once on the A1 breakpoint rectangle. Click twice on the A2 breakpoint rectangle. By leaving the A3 breakpoint rectangle unaltered it will have no effect on the breakpoint.

* If the waveform window disappears, click on the waveform button to make it visible

Reset the simulation by clicking on the Reset button in the Toolbar. Then click the Run button to start the simulation. The simulation will halt at the specified breakpoint. The right edge of the Waveforms window is the point where the actual breakpoint is registered.

Click several times on the Step button in the Toolbar to advance the Waveforms one tick at a time. As you do this you will notice that the circuit did stop when the specified condition occurred.

CircuitMaker's powerful macro feature enables you to create your own completely functional devices and nonfunctional device symbols. You can either design your own package for a macro or choose one that CircuitMaker provides. In addition, macros can be recalled from the library, expanded, edited and resaved at any time.

With the Arrow Tool, select the device on your screen labeled Macro (in SIM.CIR), then click on the Macro button in the Toolbar. Your screen will be cleared and the macro will be expanded revealing its internal circuitry. Select the device labeled Macro 2 and expand this macro. As you can see, CircuitMaker allows you to create nested macros.
This section provides a brief introduction to CircuitMaker’s analog simulation capabilities. It demonstrates creating two circuits, one a simple series resistor circuit and the other an amplifier circuit, setting up the analyses, and running the simulation.

To begin, we will create a simple series resistor circuit and demonstrate how to measure voltage and current.

1. Select New from the File menu. An “Untitled” circuit window will be opened.

2. Select Analog simulation mode. The transistor icon should be visible in the Toolbar, not the AND gate icon. If the AND gate icon is displayed on the button, click on the button.

3. Make sure the Auto Designation option in the Options menu is enabled (so there is a checkmark by it).

4. Draw the circuit as shown using the following devices: From the L1 menu select 1 Battery, from the L2 menu select 2 Resistors, and from the L1 menu select 1 Ground. Use the Wire Tool to wire the circuit together.

   Note: Every analog circuit must have a Ground device and every node must have a DC path to ground.

5. Click on the Run button in the Toolbar to start the simulation.

6. Click on the wire connected to the + terminal of the Battery with the Probe Tool. The DC voltage at that node (+10V) will be displayed in the Value window. Click on the wire connected between the two resistors. The DC voltage at that node (+5V) will be displayed in the Value window. Click on the + pin of the battery or on one of the resistor pins. The current through the circuit (5mA) will be displayed in the Value window. If you click on the wire connected to ground you will get a message stating that there isn’t any simulation data for this node. This is because SPICE does not collect data for the ground node since the node is always at 0V.

7. Click on the Stop button in the Toolbar to stop the simulation and return to editing mode.
For our next example we will create a 10X amplifier circuit using a µA741 operational amplifier. Our first example used the automatic setup mode where we let CircuitMaker choose the appropriate analysis type(s) and set up the corresponding analysis parameters. In this example we turn this automatic setup mode off in order to illustrate manually setting up the analyses.

Note: In this configuration, voltage gain = RF/RI.

1. Select New from the File menu. An “Untitled” circuit window will be opened.

2. Select Analog simulation mode. The transistor icon should be visible in the Toolbar, not the AND gate icon. If the AND gate icon is displayed on the button, click on the button.

3. Disable the Auto Designation option in the Options menu (so there is no checkmark by it). This allows us to specify our own designation for each device (e.g., Vcc, U1, RF, etc.)

4. Draw the circuit as shown (don’t worry about the values), using the following devices. From the L1 menu, select: 1 Signal Gen (Vin on the schematic), 2 +V devices (Vcc and Vee) and 2 Grounds. From the L2 menu, select: 1 Op-Amp5 (U1) and 3 Resistors (RI, RF and RL). Devices can be rotated in 90° increments by selecting the device with the mouse and clicking on the Rotate 90 button in the Toolbar. Use this method to rotate the -12V supply and RL.

Use the Wire Tool to wire the circuit together. Use the Arrow Tool to drag devices and wires to make the circuit look nice.

5. Select the Arrow Tool from the Toolbar and double-click on the op amp. Select UA741 from the list of available subcircuits (it’s near the bottom of the list) and click on the Select button. Click on the Netlist... button. Set the Designation field to “U1” and visible. Click on the OK button, then the Exit button.

6. Double-click on the TOP +V device. Set the Label-Value field to “+12V” and visible. Set the Designation field to “Vcc” and visible. Set the Device field to NOT visible. Click on the OK button.

7. Double-click on the BOTTOM +V device. Set the Label-Value field to “-12V” and visible. Set the Designation field to “Vee” and visible. Set the Device field to NOT visible. Click on the OK button. Click and drag the labels so they are positioned as shown on the schematic.

8. Double-click on each resistor to change both its Label-Value and its Designation and make them visible. Set them up as follows (refer to the circuit diagram):

<table>
<thead>
<tr>
<th>Resistor</th>
<th>Label-Value</th>
<th>Designation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td>10k</td>
<td>RI</td>
</tr>
<tr>
<td>Feedback</td>
<td>100k</td>
<td>RF</td>
</tr>
<tr>
<td>Load</td>
<td>25k</td>
<td>RL</td>
</tr>
</tbody>
</table>
9. **Double-click on the Signal Generator.** Set the Peak Amplitude to 0.1V and the frequency to 10kHz. Click on the Wave... button. **Enable the Source** checkbox for AC Analysis. Set **Magnitude** to -0.1V and **Phase** to 0. Click on OK. The Signal Generator can now be used as a reference for the AC analysis. Click on the Netlist... button. Set the **Designation** field to “Vin” and visible. Click on the OK button. Again, click on the OK button to exit.

Once the circuit has been created, we will set up the analyses. When we run the simulation, the results will be based on the setup conditions provided here.

1. **Select Analog Analyses...** from the Options menu.

2. Click on the **Always Set Defaults** checkbox so it is cleared. This gives you access to the Transient and Operating Point Analysis setups. When this box is checked, defaults are used every time you run the simulation.

3. Click on the **Set Defaults** button for default Transient Analysis setups. This will provide simulation for 5 cycles of the input signal with 200 data points. For best reliability, “Max Step” should be the same size as “Step Time”.

4. **Select DC in the Operating Point section.** This sets the initial display mode of the Value window to DC. Transient Analysis must be enabled in order to obtain DC or AC values. Operating Point Analysis must be enabled in order to use the Value window.

5. **Enable the DC Analysis.** Set it up as follows:

   Source Name  Start  Stop  Step
   Primary Vin  -1.5V  -.7V  .01V
   Secondary Vcc  10V  14V  1V

   This setup will allow us to sweep the voltage of Vin over the specified range at each of 5 different Vcc’s.

6. **Enable the AC Analysis.** Set it up as follows:

   Start Freq  Stop Freq  Test Points  Sweep
   1 Hz  1MHz  100  Linear

   This setup will allow us to plot the frequency responses of the circuit.

7. Click on the OK button to save the settings.

You have just completed everything required to prepare your own circuit for analog simulation. However, the demo version does not allow you to save this circuit or run a new simulation. In the next section you will examine the simulation data of an existing circuit.
Running the Simulation

When you run the simulation, an icon is displayed at the bottom of your screen indicating when the Berkeley SPICE3 program is executing. The amount of time it takes to finish is based on the analyses that are enabled and their setup values, the complexity of the circuit, and the speed of your computer.

2. Click on the Run button in the Toolbar to display the analysis windows.

3. Select the Tile Windows command from the View menu.

4. Click on the Value window to select it (it’s the little window that says DC in the title bar). Click on any wire in the circuit (except a wire connected to ground) with the Probe Tool. The DC voltage at that node will be displayed in the Value window. SPICE data is not collected for the Ground node in the circuit; it is always at zero volts.

5. Click on the “pin” of the +12V power supply (click above the pin dot, very close to the circle, otherwise you may get the wire instead of the pin). The DC current through that supply will be displayed in the Value window (if you clicked too close to the wire, the voltage for this node will be shown). Note: SPICE sees the current flowing into the positive terminal of a power supply, Multimeter or Signal Generator as positive current.

6. Double-click inside the Value window and change the setting to AC RMS. Click on the OK button. Now when you click on the wires in the circuit the AC voltage or current will be displayed.

7. Click on the Transient Analysis window to select it, then click on the wire connected to the output of the Signal Generator with the Probe Tool. A green waveform will be displayed in the Transient Analysis window, similar to what would be seen on an oscilloscope.

8. Hold down the SHIFT key and click on the wire connected to the output of the Op Amp. A second (yellow) waveform will be displayed in the Transient Analysis window. A quick comparison of the two waveforms will confirm that the amplitude at the output of the amplifier is much greater than the amplitude at the input.
9. Click on the ‘a’ cursor at the far right of the Transient Analysis window and drag it to the top peak of the output waveform (the yellow one). Click on the ‘b’ cursor and drag it to the top peak of the input waveform (the green one). The actual peak voltages are displayed at top of the graph as ‘Ya’ and ‘Yb’. As you can see from the ‘Ya’ and ‘Yb’ values, the peak voltage at the output of the amplifier is 10 times the peak voltage at the input of the amplifier. The difference between the two Y cursors is shown as ‘a-b’.

10. Click on the ‘b’ cursor at the top of the Transient Analysis graph and drag it to the top peak of the first cycle of the output waveform. Click on the ‘a’ cursor and drag it to the top peak of the second cycle of the output waveform. The period (period = 1/1) of the signal is shown as the difference between the two X cursors as ‘a-b’.

11. Click and drag a selection rectangle around a portion of the waveforms in the Transient Analysis window. The view will zoom in on the portion of the waveform selected. To restore the original view, click on the Reset button in the upper left hand corner of the window.

12. Click on the DC Analysis window to select it, then click on any wire in the circuit (except a wire connected to ground). A DC analysis waveform will be displayed in the window, similar to what would be seen on a curve tracer. The cursors can be used to get measurements from the waveforms.

13. Click on the AC Analysis window to select it, then click on the wire at the output of the op amp. An AC analysis waveform will be displayed in the window. Click on the Setup button in the upper left hand corner of the AC Analysis window. Select Log scale for the X Grid, select Decibels for the Y Axis, enable Solid Grid Lines for both the X and Y Grids and enable the Show Wave Grid checkbox. Click on the OK button. The waveform will now show the peak output voltage of the circuit over the specified frequency. The cursors can be used to get measurements from the waveforms.

14. Click on the Stop button in the Toolbar to stop the simulation and return to editing mode.

This concludes the introductory demonstration of CircuitMaker. Please note that this booklet is not fully comprehensive in that it does not demonstrate all of the features of CircuitMaker. Please feel free to browse through the menus and the sample circuits. Thank you for your time. If you have any additional questions or comments please feel free to contact us.
PC/MS-DOS
THE ESSENTIALS

A Brief Guide for Users
by
George Campbell

revised by
J. Edward Carryer 9/29/92
John O. Wambaugh 7/11/90
For ME218

Introduction

In order for you to use your computer effectively, there are a few basic commands from
PC/MS-DOS you need to learn. In addition, you will need to understand your
computer's disk drives and the proper care and handling of floppy disks.

This brief manual, designed for new computer users, will help you get the most from
your computer. It is organized according to the most frequently used commands. An
index at the back of the manual will help you find the sections you need.

For each command, I have provided an explanation of the command, plus
information on how to use the command in several situations. The examples should
help you perform the operations you will use every day.

There are a few conventions used in this manual which you need to know:

1. When you see a word surrounded by <->, that means to press the key marked with
   that word. For example, if you see this: <->Enter>, press the Enter (s) key.

2. In some cases, spaces are important to a command. In those cases, you will see this:
   (sp). When following an example, press the spacebar when you see (sp).

3. Otherwise, type the command as it is written in the example.

Disk Drives &
Floppy Disks

There are two basic types of disk drives you are likely to encounter:

1. Floppy disk drives.
2. Hard disk drives.

Your computer will have at least one floppy disk drive. It may well have two. The PCs
in SPDL have at least 1 floppy. These drives have names. The left or top drive is
usually called Drive A:. The right or lower disk drive (on two-drive systems) is
usually called Drive B:.

All of the SPDL systems have two hard disk drives. These drives are referred to as
Drive C: and D:. In addition, there is a directory that physically resides on a server
and appears to every machine in the lab as drive E:. This is the drive that will contain
your data files, so that no matter what machine you are using, you will have access to
the latest versions of your data.

All DOS commands refer to these drive names. In order for a command to act on a
drive, you must specify the correct drive name. For example, the command Format b:
acts on Drive B:. If you supply the wrong drive name, you may destroy data on a drive.

IMPORTANT: If you give a command without specifying a drive name, the computer
assumes you are referring to the drive name specified at the system prompt. The
standard DOS prompt looks like this:

C>

In the case of the machines in SPDL, the prompt will look something like:

E:\STUDENTS>
Floppy Disks

Floppy disks are the most common method of storing programs and data for your computer. There are four basic types:

1. 5 1/4" double-sided/double-density floppy disks.
2. 5 1/4" double-sided/high-density floppy disks.
3. 3 1/2" double-sided/double-density floppy disks.
4. 3 1/2" double-sided/high-density floppy disks

The typical IBM PC or Clone computer uses the first type. It can store 360 Kbytes of data, or about 150 pages of double-spaced type. Most often, these disks are marked DS/DD 48tpt.

The second type, used only on IBM PC/AT or compatible computers, can store 1.2 Mbytes. They are marked DS/HD 96tpt.

The third type of floppy disk is used primarily on portable computers. It can store 720 Kbytes of data, twice as much as the first type of disk. These disks are usually marked DS/DD 135tpt.

The fourth type was introduced with the IBM PS/2 series. It stores twice as much (1.44Mbytes) as a standard 3 1/2" disk. This is the lab standard disk size.

If you have an AT-type computer, its disk drives can read data written on the first type of disk. However, disks written on the High-density drives may not be read by other PC-compatible computers.

Many times, AT-type computers use a 360 Kbyte disk drive as drive B:. If this is the case, record all files to be read on other computers on drive B:. 

Inserting A Floppy Disk

Hold the disk with its label up, then insert it into the disk drive. When it is fully inserted, close the drive door with the lever, or push the drive button. On the 3 1/2" disk drives, the disk latches into place as you insert it. Use the button on the front of the disk drive to eject the disk.

Some computers have their drives in a vertical position. When inserting a disk into this type of drive, the label should face left.

Care For Floppy Disks

Floppy disks are a very reliable storage device, but they require some care. Here are some simple rules:

1. Never touch the disk surface in the exposed windows.
2. Store disks in cool, dry places. Disk storage boxes are ideal.
3. Keep floppy disks away from magnetic fields, such as motors, telephones, and other electrical devices.
4. Handle disks with care. Avoid bending them.
5. When writing on disk labels, use a felt-tip pen when the labels are attached to the disk. Avoid excess pen pressure.
6. Keep floppy disks in their protective sleeves whenever they are not in the disk drive.
7. **Store backup copies of important disks away from your workspace.** If problems occur, your programs and data will be in another location, and can be retrieved.
8. Avoid spilling anything on a floppy disk. Keep coffee and other beverages away from your computer and work areas.
9. Never remove a disk from its drive while the drive light is on. This can cause you to lose all data on the disk.

**Hard Disk Drives**

Hard disk drives, on the other hand, are more permanent. You do not remove the disk; it remains in the drive at all times.

A typical hard disk drive holds from 10 to 40 megabytes of data. This allows you to store the equivalent of up to 100 floppy disks or more on a single hard disk drive. The hard disks on the PCs in SPDL hold 80 Mbytes for student use.

Hard disk drives are typically named C: or D:. Your computer will start up with from the hard disk drive if no disk is inserted drive A:

Hard disks pretty much take care of themselves, with one exception. When you are ready to turn the machine off, you must be sure that the operating system has finished updating the hard drive. When you are ready to shut down a machine in SPDL, type:

**EXIT**

When you see the screen reminding you to turn everything off, it is safe to turn the computer off.

**Subdirectories**

With the advent of large hard disk drives came a new problem, how to keep track of all of those files. Even a 10 MegaByte disk is capable of holding hundreds of files, far too many to do without some form of organization. The mechanism that DOS adopted is called Subdirectories.

For those of you familiar with Macintoshes, the system is very similar to the folders used in the Mac Plus & newer machines.

For those of you completely new to the idea, you can think of it as an arrangement similar to the organization of a book. At the first level, the book is divided into chapters. Within each chapter there are sections, and within each section there are paragraphs. At this point the analogy breaks down, since there are no more parts to a book. On the other hand it is possible to have many more levels of subdirectories. However, more than 3 or 4 gets cumbersome.

What we have then, is a disk, sometimes referred to as a volume. The disk is organized as several subdirectories, each of which may have subdirectories of its own. The place where we start all of this is a special directory called the Root. This leads to a tree structure, beginning at the root, branching to any subdirectories from the root, with further branching possible at each subdirectory. The figure below is an example of what all this looks like.

```
Util      Students      DOS      Procomm      Editors
  ff.com  -- Ed  John  Uzi -- command.com  procomm.exe  bb.exe
        ↓      ↓      ↓       ↓ format.exe  ...  ...  emacs.exe
    lab0.asm  lab2.fth ... ...
```

Subdirectories have a few special properties.

For the most part, DOS commands only apply to the files in a subdirectory. This way you can manipulate the files in your subdirectory without affecting the files in other subdirectories.
File names, which we will discuss next, are only required to be unique within a subdirectory. So a file named Lab0 in your subdirectory will not conflict (or affect) a file with the same name in someone else's subdirectory.

As a result of the second property, it is sometimes necessary to specify EXACTLY which file named Lab0 that you mean. You do this by specifying a PATH. The Path is what you would expect it to be based on its name. The sequence of subdirectories that you need to follow, starting at the Root, to find that particular file. In the diagram above the path to Ed's lab0 is:

```
C:\students\ed
```

Notice the use of the '\ ' to separate the subdirectory names in the Path. It is also used between the last subdirectory name and the file name.

The Root directory has the special name

```
C:\`
```

Every program on your computer, and your data, is stored in files on your disk drives. There are a few things you need to know about files.

Each file within a subdirectory must have its own, unique filename. You may already be familiar with the structure of filenames, but here is a rundown:

The complete filename is made up of three parts:

1. Path Name
2. File Name
3. Extension

Let's look at a typical file:

```
C:\DOS\COMMAND.COM
```

The Path is the sequence of subdirectories, starting with the Root directory, that must be followed to find the file. If you are in the same subdirectory (see CHDIR) as the file, you do not need to include the path.

The File Name may be up to 8 characters long, and may contain letters and numbers. It is separated from the Extension by a period or decimal point.

The Extension, which can be up to 3 characters, can also be made up of both letters and numbers.

Combined, the three parts of the filename can help you identify a particular file. Choose a filename for each file carefully, to help you find that file later.

Certain extensions are reserved by DOS for specific types of files. .COM, .EXE, .BAS, and .BAT are reserved extensions, and should not be used for ordinary files. There are other conventions with respect to file names. For example:

```
.ASM Assembly language files
.C C source programs
.FTH Forth source programs
.DOC Documentation files
.TXT Plain text files.
```

Certain punctuation characters can be used in filenames, while others cannot. For simplicity's sake, avoid the use of punctuation characters in your filenames. If you feel you must, consult the DOS manual for the legal characters.

Some commands can take several forms. These separate forms are used by including various parameters with the command. Parameters, which will be discussed with each command, are indicated by a / mark. Here is an example of a command with an attached parameter:
All DOS commands must be activated by pressing the <Enter> key after typing the command.

NOTE: You can type all DOS commands in either upper or lower case letters.

The computers in SPDL have an extensive help system for the available applications. I encourage you to explore this help system.

When you make a mistake when entering a command, or if another type of problem occurs, DOS will place an error message on the screen. The following are the most common messages you will see. Suggestions for correcting the error are provided following the message.

Bad command or file name
DOS cannot find the file or command you entered. Check your typing and the PATH you have specified for errors.

Disk Drive Error: Abort, Ignore, Retry?
DOS has detected an error on a disk drive. Most often, this message appears when you have forgotten to insert a floppy disk into the drive, or have failed to close the door. Correct the problem, then press R for retry. Pressing A returns you to the system prompt.

If this message should appear when you are trying to access your hard disk drive...STOP. Get help from someone who knows the system well.

File cannot be copied onto itself
You have tried to copy a file to the same filename on the same drive. Check your command.

File not found
DOS can't find the file you specified. Check your typing and make sure you have given the correct path.

Format failure
An error has occurred when using the FORMAT command. DOS will provide an explanation with this error message. Take the appropriate corrective measures.

Insufficient disk space
The disk you are working with does not have enough space to hold the data. Replace with a new, formatted disk and repeat the operation.

Insufficient memory
Your computer does not have enough memory for the operation you have named. Consider expanding your system's memory size. Memory expansion is relatively inexpensive.

Invalid Disk Drive
The drive name you specified does not exist on your computer. Check your typing.

Invalid number of parameters
You have mis-typed the command or specified information not acceptable to DOS. Check the command for errors.
WHEN YOUR COMPUTER CRASHES

No matter how careful you are, there will be times when your computer gets confused. Usually, when this happens, the keyboard will lock up and nothing you type will have any effect. Other problems sometimes occur, including a drive that won't stop running.

When using commercial software, these problems are infrequent, but do happen from time to time. Most often, you will lock your system up when experimenting with your own programs. There are three ways to get out of a locked system. Try these in the order shown below.

1. Hold down the <Ctrl> key while you press the <Scroll Lock/Break> key. This will often get you out of the program and return you to the system prompt. If it does, you're back in business.

2. Press the <Ctrl>, <Alt>, and <Del> keys at the same time. Hold each key down as you press the others. This is called a "warm boot." It usually does the trick, but wipes out whatever information is stored in your computer's memory.

3. Finally, if none of the other methods work, turn off the computer, wait a few seconds, then turn it back on. As before, data stored in memory will be lost. This last method is absolutely guaranteed, however, to restart your system.
APPLICATIONS

PROBE COMPENSATION

If accurate measurements are to be made, the effect of the probe being used must be properly adjusted output of the measurement system using the internal calibration signal or some other squarewave source.

1. Connect the probe to the channel to be used and set the various controls for a normal A sweep display.
2. Adjust the SCAPE TIME/DIV control display of several cycles of the signal from the calibration output, CAL, terminal.
3. Adjust the probe compensation control for a proper waveform display.
4. The other channels are compensated for in the same way. Note that for CH3 and CH4 the sensitivity is 0.1V/DIV so that when using a 10:1 probe sufficient waveform amplitude is not available, so that an alternate squarewave signal generator must be used for the compensating procedure.

TRACE ROTATION COMPENSATION

Rotation from a horizontal trace position can be the cause of measurement errors. Adjust the controls for a normal display. Set the AC-GND-DC switch to GND and TRIG MODE to AUTO. Adjust the \( \uparrow \) POSITION control such that the trace is over the center horizontal graduation line. If the trace appears to be rotated from horizontal, align it with the center graduation line using the TRACE ROTATION control located on the bottom of the instrument.

DC VOLTAGE MEASUREMENTS

This procedure describes the measurement procedure for DC waveforms.
Procedure:
1. Connect the signal to be measured to the INPUT connector and set the V MODE to the channel to be used.

Set the VOLTS/DIV and SCAPE TIME/DIV switch to obtain a normal display of the waveform to be measured. Set the VARIABLE control to the CAL position.
2. Set TRIG MODE to AUTO and AC-GND-DC to the GND position, which establishes the zero volt reference. Using the \( \downarrow \) POSITION control, adjust the trace position to the desired reference level position, making sure not to disturb this setting once made.
3. Set the AC-GND-DC switch to the DC position to observe the input waveform, including its DC component. If an appropriate reference level or VOLTS/DIV setting was not made, the waveform may not be visible on the CRT screen at this point. If so, reset VOLTS/DIV and/or the \( \uparrow \) POSITION control to locate.
4. Use the \( \leftrightarrow \) POSITION control to bring the portion of the waveform to be measured to the center vertical graduation line of the CRT screen.
5. Measure the vertical distance from the reference level to the point to be measured, the reference level can be rechecked by setting the AC-GND-DC switch again to GND.

Multiply the distance measured above by the VOLTS/DIV setting and the probe attenuation ratio as well. If " \( \times 5 \) GAIN" has been set multiply the value by 1/5 as well.
Voltages above and below the reference level are positive and negative values respectively.

Using the formula:

\[
DC \text{ level} = \text{Vertical distance in divisions} \times (\text{VOLTS/DIV setting}) \times (\text{probe attenuation ratio}) \times " \times 5 \text{ GAIN" value}^{\frac{1}{5}}
\]

(1/5)

[EXAMPLE]

For the example, the point being measured is 3.8 divisions from the reference level (ground potential). If the VOLTS/DIV was set to 0.2V and a 10:1 probe was used.
Substituting the given values:
\[
DC \text{ level} = 3.8 \text{ (div)} \times 0.2(\text{V}) \times 10 = 7.6V
\]
APPLICATIONS

MEASUREMENT OF THE VOLTAGE BETWEEN TWO POINTS ON A WAVEFORM

This technique can be used to measure peak-to-peak voltages.

Procedure:
1. Apply the signal to be measured to the INPUT, set the V MODE to the channel to be used and AC-GND-DC to AC, adjusting VOLTS/DIV and SWEEP TIME/DIV for a normal display. Set VARIABLE to the CAL position.
2. Using the $\downarrow$ POSITION control adjust the waveform position such that one of the two points falls on a CRT graduation line and that the other is visible on the display screen.
3. Using the $\rightarrow$ POSITION control, adjust the second point to coincide with the center vertical graduation line.
4. Measure the vertical distance between the two points and multiply this by the setting of the VOLTS/DIV control.
   
   If a probe is used, further multiply this by the attenuation ratio, if any and if " $\times$ 5 GAIN" is used, multiply the value by 1/5 as well.

Using the formula:

$$\text{Volts Peak-to-Peak} = \text{Vertical distance (div)} \times (\text{VOLTS/DIV setting}) \times (\text{probe attenuation ratio}) \times " \times 5 \text{GAIN" value}^1 (1/5)$$

[EXAMPLE]

For the example, the two points are separated by 4.4 divisions vertically. Let the VOLTS/DIV setting be 0.2V/div and the probe attenuation be 10:1.

Substituting the given value:

Voltage between two points = 4.4 (div) $\times$ 0.2 (V) $\times$ 10 = 8.8V

ELIMINATION OF UNDESIRABLE SIGNAL COMPONENTS

The ADD feature can be conveniently used to cancel out the effect of an undesired signal component which is superimposed on the signal you wish to observe.

Procedure:
1. Apply the signal containing an undesired component to the CH1 INPUT and the undesired signal itself alone to the CH2 INPUT.
2. Set the V MODE to DUAL (CHOP) and SOURCE to CH2. Verify that CH2 represents the unwanted signal in reverse polarity. If necessary reverse polarity by setting CH2 to INV.
3. Set V MODE to ADD, SOURCE to V MODE and CH2 VOLTS/DIV and VARIABLE so that the undesired signal component is cancelled as much as possible. The remaining signal should be the signal you wish to observe alone and free of the unwanted signal.

[Diasagry graph showing signal containing undesired component and undesired component signal with annotations]

[Diagram showing adjustment of horizontal and vertical scales with $\rightarrow$ POSITION]
APPLICATIONS

TIME MEASUREMENTS
This is the procedure for making time measurements between two points on a waveform. The combination of the SWEEP TIME/DIV and the horizontal distance in divisions between the two points is used in the calculation.

Procedure:
1. Apply the signal to be measured to the INPUT connector and set the V MODE to the channel to be used. Adjust VOLTS/DIV and SWEEP TIME/DIV for a normal display.
2. Be sure that the VARIABLE control is set to CAL.
3. Using the POSITION control, set one of the points to be used as a reference to coincide with the horizontal center line.
4. Use the POSITION control to set this point at the intersection of any vertical graduation line.
5. Measure the horizontal distance between the two points.
6. Multiply this by the setting of the A SWEEP TIME/DIV control to obtain the time between the two points. If horizontal "x 10 MAG" is used, multiply this further by 1/10.

Using the formula:

\[
\text{Time} = \text{Horizontal distance (div)} \times (\text{SWEEP TIME/DIV setting}) \times x 10 \text{ MAG value} \times (1/10)
\]

[EXAMPLE]
For the example, the horizontal distance between the two points is 5.4 divisions. If the SWEEP TIME/DIV is 0.2ms/div we calculate:

Substituting the given value:

\[
\text{Time} = 5.4 \text{ (div)} \times 0.2 \text{ (ms)} = 1.08 \text{ms}
\]

FREQUENCY MEASUREMENTS
Frequency measurements are made by measuring the period of one cycle of waveform and taking the reciprocal of this time value as the frequency.

Procedure:
1. Set the oscilloscope up to display one cycle of waveform (one period).
2. The frequency is the reciprocal of the period measured.

Using the formula:

\[
\text{Freq} = \frac{1}{\text{period}}
\]

[EXAMPLE]
A period of 40\mu s is observed and measured.

Substituting the given value:

\[
\text{Freq} = \frac{1}{(40 \times 10^{-4})} = 2.5 \times 10^4 = 25 \text{ kHz}
\]
APPLICATIONS

While the above method relies on the measurement directly of the period of one cycle, the frequency may also be measured by counting the number of cycles present in a given time period.

1. Apply the signal to the INPUT, setting the V MODE to the channel to be used and adjusting the various controls for a normal display. Set A VAR to CAL.
2. Count the number of cycles of waveform between a chosen set of vertical graduation lines.
Using the horizontal distance between the vertical lines used above and the SWEEP TIME/DIV the time span may be calculated. Multiply the reciprocal of this value by the number of cycles present in the given time span.
If “× 10 MAG” is used multiply this further by 10.
Note that errors will occur for displays having only a few cycles.

Using the formula:
Freq = \# of cycles × “ × 10 MAG” value
Horizontal distance (div) × SWEEP TIME/DIV setting

EXAMPLE
For the example, within 7 divisions there are 10 cycles.
The SWEEP TIME/DIV is 5 μs.

Substituting the given value:
Freq = \( \frac{10}{7 \times 5 \text{ (μs)}} \) = 285.7 kHz

PULSE WIDTH MEASUREMENTS

Procedure:
1. Apply the pulse signal to the INPUT and set the V MODE to the channel to be used.
2. Use VOLTS/DIV, VARIABLE and 4 POSITION to adjust the waveform such that the pulse is easily observed and such that the center pulse width coincides with the center horizontal line on the CRT screen.
3. Measure the distance between the intersection of the pulse waveform and the center horizontal line in divisions. Be sure that the A VAR is in the CAL position. Multiply this distance by the A SWEEP TIME/DIV and by 1/10 is “× 10 MAG” mode is being used.

Using the formula:
\[ \text{Pulse width} = \text{Horizontal distance (div)} \times \left( \text{SWEEP TIME/DIV setting} \times \text{“} \times \text{10 MAG} \text{” value} \right) \times \frac{1}{10} \]

EXAMPLE
For the example, the distance (width) at the center horizontal line is 4.6 divisions and the A SWEEP TIME/DIV is 0.2 ms.
Substituting the given value:
Pulse width = 4.6 (div) × 0.2 ms = 0.92 ms

PULSE RISETIME AND FALLOFF TIME MEASUREMENTS

For risetime and falltime measurements, the 10% and 90% amplitude points are used as starting and ending reference points.

Procedure:
1. Apply a signal to the INPUT and set V MODE to the channel to be used.
   Use VOLTS/DIV and VARIABLE to adjust the waveform peak to peak height to six divisions.
2. Using the 4 POSITION control and the other controls, adjust the display such that the waveform is centered vertically in the display. Set the SWEEP TIME/DIV to as fast a setting as possible consistent with observation of both the 10% and 90% points. Set the A VAR to the CAL position.
3. Use the 4 POSITION control to adjust the 10% point to coincide with a vertical graduation line and measure the distance in divisions between the 10% and 90% points on the waveform. Multiply this by the SWEEP TIME/DIV and also by 1/10, if “× 10 MAG” mode was used.

CAUTION
Be sure that the correct 10% and 90% lines are used.
For such measurements the 0, 10, 90 and 100% points are marked on the CRT screen.

Using the formula:
Risetime = Horizontal distance (div) × (SWEEP TIME/DIV setting) × “× 10 MAG” value \times \frac{1}{10}
APPLICATIONS

[EXAMPLE]
For the example, the horizontal distance is 4.0 divisions.
The SWEEP TIME/DIV is 2μs.

Substituting the given value:
Risetime = 4.0 (div) x 2 (μs) = 8μs

Risetime and falltimes can be measured by making use of
the alternate step 3' as described below as well.

4. Use the ↔ POSITION control to set the 10% point
to coincide with the center vertical graduation line and
measure the horizontal distance to the point of
the intersection of the waveform with the center horizontal
line. Let this distance be D1. Next adjust the waveform
position such that the 90% point coincides with the
vertical centerline and measure the distance from that
line to the intersection of the waveform with the hori-
izontal centerline. This distance is D2. The total hori-
izontal distance is then D1 plus D2 for use in the above
relationship in calculating the risetime or falltime.

Using the formula:
Risetime = (D1 + D2) (div) x (SWEEP TIME/DIV setting)
× "x 10 MAG" value\(^{-1}\) + \(\sqrt{10}\)

[EXAMPLE]
For the example, the measured D1 is 1.8 divisions while D2 is
2.2 divisions. If SWEEP TIME/DIV is 2μs we use the fol-
lowing relationship

Substituting the given value:
Risetime = (1.8 + 2.2) (div) x 2 (μs) = 8μs

TIME DIFFERENCE MEASUREMENTS

This procedure is useful in measurement of time differences
between two signals that are synchronized to one another
but skewed in time.

Procedure:
1. Apply the two signals to CH1 and CH2 and set the V
   MODE to DUAL choosing either ALT or CHOP mode.
   Generally for low frequency signals CHOP is chosen
   with ALT used for high frequency signals.
2. Select the faster of the two signals as the SOURCE and
   use VOLTS/DIV and SWEEP TIME/DIV to obtain an
easily observed display.
   Set A VAR to CAL
3. Using the ↔ POSITION control set the waveforms to the
   center of the CRT display and use the ↔ POSITION
   control to set the reference signal to be coincident with
   a vertical graduation line.
4. Measure the horizontal distance between the two sig-
   nals and multiply this distance in divisions by the
   SWEEP TIME/DIV setting.
   If \(\times 10\) MAG is being used multiply this again by 1/10.

Using the formula:
Time = Horizontal distance (div) \times (SWEEP TIME/
DIV setting) \times " \times 10 MAG" value\(^{-1}\) (1/10)

[EXAMPLE]
For the example, the horizontal distance measured is 4.4
divisions. The SWEEP TIME/DIV is 0.2ms.

Substituting the given value:
Time = 4.4 (div) \times 0.2(ms) = 0.88ms
APPLICATIONS

PHASE DIFFERENCE MEASUREMENTS
This procedure is useful in measuring the phase difference of signals of the same frequency.
1. Apply the two signals to the CH1 and CH2 INPUTS, setting the V MODE to DUAL and choosing either CHOP or ALT mode.
2. Set the SOURCE to the signal which is leading in phase and use VOLTS/DIV to adjust the signals such that they are equal in amplitude. Adjust the other controls for a normal display.
3. Use SWEEP TIME/DIV and A VAR to adjust the display such that one cycle of the signals occupies 8 divisions of horizontal display.
   Use the ↓ POSITIONS to bring the signals in the center of the screen.
   Having set up the display as above, one division now represents 45° in phase.
4. Measure the horizontal distance between corresponding points on the two waveforms.

Using the formula:
Phase difference = horizontal distance (div) × 45°/div

Phase difference = horizontal distance of new sweep range (div) × 45°/div
× New SWEEP TIME/DIV setting
Original SWEEP TIME/DIV setting

Another simple method of obtaining more accuracy quickly is to simply use × 10 MAG for a scale of 4.5°/div.

[EXAMPLE]
For the example, the horizontal distance is 1.7 divisions.
Substituting the given value:
The phase difference = 1.7 (div) × 45°/div = 76.5°

The above setup allows 45° per division but if more accuracy is required the SWEEP TIME/DIV may be changed and magnified without touching the A VAR control and if necessary the trigger level can be readjusted.

For this type of operation, the relationship of one division to 45° no longer holds. Phase difference is defined by the formula as follow.

RELATIVE MEASUREMENTS
If the frequency and amplitude of some reference signal are known, an unknown signal may be measured for level and frequency without use of the VOLTS/DIV or SWEEP TIME/DIV for calibration.
The measurement is made in units relative to the reference signal.

★ Vertical Sensitivity
Setting the relative vertical sensitivity using a reference signal.
1. Apply the reference signal to the INPUT and adjust the display for a normal waveform display.
APPLICATIONS

Adjust VOLTS/DIV and VARIABLE so that the signal coincides with the CRT face's graduation lines. After adjusting, be sure not to disturb the setting of the VARIABLE control.

2. The vertical calibration coefficient is now the reference signal's amplitude (in volts) divided by the product of the vertical amplitude set in step 1 and the VOLTS/DIV setting.

Using the formula:
Vertical coefficient
= Voltage of the reference signal (V) / Vertical amplitude (div) × VOLTS/DIV setting

3. Remove the reference signal and apply the unknown signal to the INPUT, using the VOLTS/DIV control to adjust the display for easy observation. Measure the amplitude of the displayed waveform and use the following relationship to calculate the actual amplitude of the unknown waveform.

Amplitude of the unknown signal (V)
= Vertical distance (div) × Vertical coefficient × VOLTS/DIV setting

[EXAMPLE]
For the example the VOLTS/DIV is 1V.
The reference signal is 2 Vrms. Using the VARIABLE, adjust so that the amplitude of the reference signal is 4 divisions.

Substituting the given value:
Vertical coefficient = 2 Vrms / 4 (div) × 1 (V) = 0.5

Then, measure the unknown signal and VOLTS/DIV is 2V and vertical amplitude is 3 divisions.

Substituting the given value:
Effective value of unknown signal = 3 (div) × 0.5 × 5(V)
= 7.5 V rms

PERIOD

Setting the relative sweep coefficient with respect to a reference frequency signal:

1. Apply the reference signal to the INPUT, using VOLTS/DIV and VARIABLE to obtain an easily observed waveform display

Using SWEEP TIME/DIV and VARIABLE adjust one cycle of the reference signal to occupy a fixed number of scale divisions accurately. After this is done be sure not to disturb the setting of the VARIABLE control.

2. The Sweep (horizontal) calibration coefficient is then the period of the reference signal divided by the product of the number of divisions used in step 1 for setup of the reference and the setting of the SWEEP TIME/DIV control.

Using the formula:
Sweep coefficient
= Period of the reference signal (sec) / Horizontal width (div) × SWEEP TIME/DIV setting

3. Remove the reference signal and input the unknown signal, adjusting the SWEEP TIME/DIV control for easy observation.

Measure the width of one cycle in divisions and use the following relationship to calculate the actual period.

Using the formula:
Period of unknown signal = Width of 1 cycle (div) × sweep coefficient × SWEEP TIME/DIV setting
APPLICATIONS

[EXAMPLE]
A SWEEP TIME/DIV is 0.1ms and apply 1.75kHz reference signal. Adjust the A VAR so that the distance of one cycle is 5 divisions.
Substituting the given value:
Horizontal coefficient = \( \frac{1.75 \text{kHz}^{-1}}{5 \times 0.1 \text{ms}} = 1.142 \)
Then, SWEEP TIME/DIV is 0.2ms and horizontal amplitude is 7 divisions.
Substituting the given value:
Pulse width = \( 7 \text{ div} \times 1.142 \times 0.2 \text{ ms} = 1.6 \text{ ms} \)

PULSE JITTER MEASUREMENTS
1. Apply the signal to the INPUT and set the V MODE to the channel to be used.
   Use VOLTS/DIV to adjust for an easy to observe waveform display. Special care should be taken to adjust the Trigger group of controls for a stable display.
   Set A VAR to CAL
2. Set the HORIZONTAL DISPLAY to A-INT-B, and set the B SOURCE switch to STARTS AFTER DELAY mode. Adjust the DELAY TIME MULTIPLIER for intensified display of the waveform to be measured.
3. Using the B SWEEP TIME/DIV, adjust the display for intensification of the entire jitter area of the waveform.
4. Set the HORIZONTAL DISPLAY to B DLY'D.
   Measure the width of the jitter area.
   The jitter time is this width in divisions multiplied by the setting of the B SWEEP TIME/DIV control.

Using the formula:
Pulse jitter = Jitter width (div) \times B SWEEP TIME/DIV setting

[EXAMPLE]
The example shows a case in which the jitter width was measured at 1.6 divisions wide with the B SWEEP TIME/DIV set at 0.2\( \mu \)s.
Substituting the given value:
Pulse jitter = \( 1.6 \times 0.2 \mu \text{s} = 0.32 \mu \text{s} \)

SWEEP MULTIPLICATION (MAGNIFICATION)
The apparent magnification of the delayed sweep is determined by the values set by the A and B SWEEP TIME/DIV controls
1. Apply a signal to the INPUT and set the V MODE to the channel to be used, adjusting VOLTS/DIV for an easily observed display of the waveform and the other controls if necessary.
2. Set the A SWEEP TIME/DIV so that several cycles of the waveform are displayed. Set the B SOURCE to STARTS AFTER DELAY mode.
   When HORIZONTAL DISPLAY is set to A-INT-B, the magnified portion of the waveform will appeared intensified on the CRT display.
3. Use the DELAY TIME MULTIPLIER to shift the intensified portion of waveform to correspond with the section to be magnified for observation. Use the B SWEEP TIME/DIV to adjust intensified portion to cover the entire portion to be magnified.
4. Set the HORIZONTAL DISPLAY to either ALT or B DLY'D and use the \( \frac{1}{2} \) POSITTION and \( \frac{1}{2} \) TRACE SEP controls to adjust the display for easy viewing.
5. Time measurements are performed in the same manner from the B sweep as was described above for A sweep time measurements.
The apparent magnification of the intensified waveform section is the A SWEEP TIME/DIV divided by the B SWEEP TIME/DIV.

Using the formula:
The apparent magnification of the intensified waveform = \( \frac{A \text{ SWEEP TIME/DIV setting}}{B \text{ SWEEP TIME/DIV setting}} \)
APPLICATIONS

[EXAMPLE]
In the example, the A SWEEP TIME is 2μs and the B SWEEP TIME is 0.2μs.

Substituting the given value:
Apparent magnification ratio = \( \frac{2 \times 10^4}{0.2 \times 10^4} = 10 \)

With the above magnification, if the magnification ratio is increased, delay jitter will occur.
To achieve a stable display, cancel the STARTS AFTER DELAY mode and use the triggered mode of operation.

1. Perform the above steps 1 through 3.
2. Set the B SOURCE to the same signal as the A trigger source.
3. Set the HORIZONTAL DISPLAY to either ALT or B DLY’D. The apparent magnification will be the same as described above.
   If a proper B trigger signal is not applied, intensification may not occur. If this happens, vary the signal level or trigger with an external signal source.

DELAYED SWEEP TIME MEASUREMENTS
Using the B sweep, high accuracy time measurements can be made.
1. Apply a signal to INPUT and set the V MODE to the channel to be used. Adjust VOLTS/DIV and the other controls if necessary to obtain an easily observed waveform display.
   Set the A VAR to CAL.
2. Adjust the A SWEEP TIME/DIV to display the portion of waveform to be measured. Set the B SOURCE switch to STARTS AFTER DELAY mode.
   Set the HORIZONTAL DISPLAY to A-INT-B and adjust the B SWEEP TIME/DIV for as small as possible an intensified region.
3. Using the \( \text{POSITION} \) control adjust the waveform position so as to intersect with the center horizontal line on the CRT screen. Use the DELAY TIME MULTIPLIER so that the intensified portion of waveform touches the center horizontal line and record the setting of the DELAY TIME MULTIPLIER at this point.

4. Use the DELAY TIME MULTIPLIER to adjust intensified portion to same point of the second waveform.
The waveform period is the second dial reading minus the first dial reading multiplied by the A SWEEP TIME/DIV setting.

Using the formula:
Period = (2nd dial reading − 1st dial reading) 
\times \text{Delayed sweep time ( A SWEEP TIME/DIV setting )}

[EXAMPLE]
For the example the first dial setting is 1.01 and the second is 6.04. The setting of A SWEEP TIME/DIV is 2ms.

Substituting the given value:
Period = (6.04 − 1.01) \times 2 (ms) = 10.06ms

PULSE WIDTH MEASUREMENTS USING DELAYED SWEEP
This method is similar to the time measurement method and can be used for high accuracy pulse width measurements.
1. Apply the pulse signal to the INPUT and set the V MODE to the channel to be used.
2. Use the VOLTS/DIV, VARIABLE and \( \text{POSITION} \) controls to adjust the display such that the waveform is easily observable with the center of the pulse width coinciding with the center horizontal graduation line. Set A VAR to CAL.
3. Set the A SWEEP TIME/DIV to display the portion of the waveform to be measured, setting the B SOURCE switch to STARTS AFTER DELAY mode.
   Set the HORIZONTAL DISPLAY to A-INT-B, and adjust the B SWEEP TIME/DIV for as small as possible an intensified section of waveform.
4. Using the DELAY TIME MULTIPLIER, adjust the display so that the intensified portion touches the center horizontal graduation line of the CRT screen and record the dial setting at this point.
APPLICATIONS

5. Using the DELAY TIME MULTIPLIER adjust the falling edge of the pulse so that it touches the center horizontal graduation line and is intensified. The pulse width is the second dial reading minus the first dial reading multiplied by the A SWEEP TIME/DIV setting.

Using the formula:
\[ \text{Pulse width} = (2\text{nd dial reading} - 1\text{st dial reading}) \times \text{Delayed sweep time (A SWEEP TIME/DIV setting)} \]

[EXAMPLE]
In the example, the first dial reading is 0.61 and the second is 5.78 with the A SWEEP TIME/DIV setting at 2\(\mu s\). Substituting the appropriate values

\[ \text{Pulse width} = (5.78 - 0.61) \times 2 (\mu s) = 10.34 \mu s \]

FREQUENCY MEASUREMENTS USING DELAYED SWEEP
The frequency is obtained as the reciprocal of the period of one cycle.
1. Measure the period of the waveform using the procedure described above for time measurement.
2. The frequency is then the reciprocal of the period measured.

Using the formula:
\[ \text{Freq} = \frac{1}{\text{Period}} \]

[EXAMPLE]
For the example, the period measured is 40.2\(\mu s\), making the frequency simply

Substituting the given value:
\[ \text{Freq} = \frac{1}{40.2 \times 10^{-6}} = 24.88 \text{ kHz} \]

PULSE REPETITION TIME
Using the delayed sweep feature, reliable time measurements can be made.
1. Apply a signal to the INPUT and set the V MODE to the channel to be used.
   Adjust VOLTS/DIV to obtain a normal easy to view display of the waveform.
2. Adjust the A SWEEP TIME/DIV so that at least two cycles of the waveform are displayed.
   Set the HORIZONTAL DISPLAY to A-INT-B and set the B SOURCE switch to STARTS AFTER DELAY mode.
   Set the B SWEEP TIME/DIV as fast a sweep speed as possible.
3. Using the DELAY TIME MULTIPLIER, adjust the intensified portion to coincide with the first pulse.
   Set the HORIZONTAL DISPLAY to ALT and use ‡ TRACE SEP to adjust the waveforms for easy viewing.
4. Using the DELAY TIME MULTIPLIER, set the pulse to coincide with one of the vertical graduation lines and record the dial setting at this point.
5. Again using the DELAY TIME MULTIPLIER, adjust the second pulse in the same manner to the vertical line used in step 4, recording this dial setting as well. The pulse repetition time is the second dial reading minus the first dial reading multiplied by the A SWEEP TIME/DIV control setting.

Using the formula:
\[ \text{Pulse repetition time} = (2\text{nd dial reading} - 1\text{st dial reading}) \times \text{Delayed. sweep time (A SWEEP TIME/DIV setting)} \]
APPLIcATIONS

[EXAMPLE]
For the example, the first dial reading is 0.76 and the second is 6.22 with the A SWEEP TIME/DIV set at 2μs.
We have, substituting the appropriate values

Pulse repetition time = (6.22 - 0.76) x 2 (μs) = 10.92μs

USING DELAYED SWEEP FOR MEASUREMENT OF RISETIMES AND FALLTIMES
Risetimes and falltimes are generally measured by using the 10% and 90% amplitude points as reference starting and ending points for the rise or fall.
1. Apply the signal to the INPUT and set the V MODE to the channel to be used.
Use VOLTS/DIV and VARIABLE to obtain a normal 6 division high waveform display.
2. Using the POSITION control, set the waveform position in the central area of the screen vertically, that it to coincide with the 100% and 0% lines on the CRT screen.
Set the SWEEP TIME/DIV to as high a speed as possible consistent with observation of both the 10% and 90% points.
Set A VAR to the CAL position.
3. Set the B SOURCE switch to STARTS AFTER DELAY mode and adjust the B SWEEP TIME/DIV for as short as possible an intensified section of waveform.
4. Using the DELAY TIME MULTIPLIER, adjust the waveform such that the 10% point is intensified and record the dial reading.
5. Similarly, using the DELAY TIME MULTIPLIER adjust the 90% point so that it is intensified and record that dial reading as well.
The pulse risetime (or falltime) is simply the difference between the two dial settings times the A SWEEP TIME/DIV control setting.
Using the formula
Risetime = (2nd dial reading - 1st dial reading) x Delayed sweep time (A SWEEP TIME/DIV setting)

[EXAMPLE]
For the example, the first dial reading is 1.20 (10% point) and the second is 7.38 (90% point) with the A SWEEP TIME/DIV set at 2μs.
Substituting the given value:
Risetime = (7.38 - 1.20) x 2 (μs) = 12.36μs

TIME DIFFERENCE MEASUREMENTS USING DELAYED SWEEP
Synchronized waveforms which are skewed in time can be accurately measured using the delayed sweep.
1. Apply the two signals to the CH1 and CH2 INPUTs, setting the V MODE to DUAL and selecting either ALT or CHOP display.
2. Set the SOURCE to the signal that is leading in phase and adjust VOLTS/DIV and SWEEP TIME/DIV for easy waveform observation.
Set the A VAR control to CAL.
3. Set the B SOURCE switch to STARTS AFTER DELAY mode. Set the HORIZONTAL DISPLAY to A-INT-B and adjust the B SWEEP TIME/DIV and DELAY TIME MULTIPLIER to make the intensified portion coincide with the rising edge or falling edge of the waveform that is to be used as the reference.
4. Set the HORIZONTAL DISPLAY to ALT and use the TRACE SEP control to adjust the B sweep for easy observation.
5. Using the DELAY TIME MULTIPLIER adjust the pulse to any convenient vertical graduation line and record the dial reading at that point.
6. Using the DELAY TIME MULTIPLIER adjust the corresponding point on the second signal to the same vertical line and record the reading of the dial at this point as well. The time difference or skew of the two waveforms is then the second dial reading minus the first dial reading multiplied by the A SWEEP TIME/DIV control setting.
APPLICATIONS

Using the formula:

\[
\text{Time difference} = \frac{(2\text{nd dial reading} - 1\text{st dial reading})}{\text{Delayed sweep time (A SWEEP TIME/DIV setting)}}
\]

\[= \frac{5.34 - 1.00}{2\mu s} = 8.66 \mu s\]

X-Y OPERATION

PHASE MEASUREMENT

Phase measurements may be made with X-Y operation. Typical applications are in circuits designed to produce a specific phase shift, and measurement of phase shift distortion in audio amplifiers or other audio networks. Distortion of amplitude is also displayed in the oscilloscope waveform.

To make phase measurements, use the following procedure:

1. Using an audio signal generator with a pure sinusoidal signal, apply a sine wave test signal at the desired test frequency to the audio network being tested.
2. Set the signal generator output for the normal operating level of the circuit being tested. If desired, the circuit's output may be observed on the oscilloscope. If the test circuit is overdriven, the sine wave display on the oscilloscope is clipped and the signal level must be reduced.

\[\sin \phi = \frac{B}{A}\]

WHERE \(\phi\) = PHASE ANGLE

3. Connect the Channel 1 probe to the output of the test circuit.
4. Set the HORIZONTAL DISPLAY to X-Y.
5. Connect the Channel 2 INPUT probe to the input of the test circuit.
6. Adjust the Channel 1 and 2 gain controls for a suitable viewing size.
7. Some typical results are shown above. If the two signals are in phase, the Lissajous pattern is a straight diagonal line. If the vertical and horizontal gain are properly adjusted, this line is at a 45° angle.

A 90° phase shift produces a circular Lissajous pattern. Phase shift of less (or more) than 90° produces an elliptical Lissajous pattern. The amount of phase shift can be calculated from the oscilloscope trace as shown left below.

FREQUENCY RESPONSE MEASUREMENTS

1. Connect the RF or AF output of a sweep generator to the input of the circuit under test. Connect the output of the circuit under test to the CH1 INPUT; a demodulator probe will provide a standard frequency response curve, but a standard probe can be used which will result in an envelope display.
2. Connect the sweep voltage output of the sweep generator to the CH2 INPUT.
3. Set the HORIZONTAL DISPLAY to X-Y, and adjust the CH1 and CH2 controls for suitable viewing size.